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Version 22.1 Release Notes

This document provides important information regarding new features and changes in your Sage
Estimating 22.1 software. Read these release notes carefully before installing Sage Estimating 22.1.

Installation Notes

System Requirements

For current information about supported operating systems, Internet browsers, Microsoft® SQL Server®, and
other software, and about system requirements for servers and client workstations, refer to our
Knowledgebase article ID 116801, available at
https://support.na.sage.com/selfservice/viewdocument.do?externalld=116801.

Note: The system requirements are the minimum for a computer running Estimating with one SQL
Server instance. Running several other business programs with multiple SQL Server instances may
affect the performance of your system.

Migration from Estimating (Pervasive) to Versions after v20.1

The migration path from Estimating (Pervasive) to this release is not direct. If you have been using a
Pervasive-based version of Sage Estimating, you need to:

1. Migrate (transfer) your existing Pervasive-based data to Estimating (SQL) v20.1.

Important! Sage recommends that you first migrate your data to a test environment to ensure that the
migration proceeds smoothly. For example, if there are errors in your Pervasive-based data, you have
an opportunity to correct them in that version before migrating the data to a live environment.

2. Upgrade your database from v20.1 to this release.

For information about migrating your Pervasive-based data to Estimating (SQL), see the
version 20.1 Installation and Administration Guide.

Tip: You can continue to operate v20.1 alongside this current release. If you have a large number of
estimates in Estimating (Pervasive, you can migrate them to version 20.1, export them from version 20.1,
and then import them later into this version, as needed.
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Installing Sage Estimating

Refer to the Installation and Administration Guide for complete instructions on installing the software and
migrating or upgrading your data.

Before Installing

Important!

« Microsoft .NET 4.8 is required for Estimating. If it is not already installed on your computer, the
Estimating installation will require a restart. If you prefer not to restart when installing Estimating,
firstinstall .NET 4.8 from the Prerequisites folder (in the Install folder), and then restart your
computer before installing Estimating.

If you receive a message about .NET during installation, stop the installation, restart your
computer, and then run the installation program again.

» Sage Estimating (SQL) version 22.1 is compatible with version 21.1 of Sage 300 Construction
and Real Estate, and later. If you integrate Estimating with Sage 300 Construction and Real
Estate for Job Cost or Project Management, do not install Sage Estimating (SQL) version 22.1
until you install Sage 300 Construction and Real Estate version 21.1, or later.

« If you are using third-party software that integrates with Sage Estimating, check with the third-
party software vendor to ensure that their software is compatible with version 22.1 before you
upgrade to this version.
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We've been listening to you!

Sage thanks you for your product ideas!
In Sage Estimating (SQL) version 22.1, we have incorporated the following customer requests:

« When you merge estimates that include alternates, the merged estimates now include the alternates
from the original estimate.

Thank you for this suggestion, Mike O.
» The Assembily field displays assembly nhumbers up to 20-digits long.
Thank you for this suggestion, Lou P.

» The report printing window now includes a check box that you can select if you want to print a cell's
highlight cell color.

Thank you for this suggestion, Ross K.
* You can add price change date columns to spreadsheet layouts.

Thank you for this suggestion, Stan H.
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New Features and Enhancements

Sage Estimating version 22.1 introduces the following significant features:

* A new External Report capability in the Estimating Management Console that you can use to generate
estimate data that will persist in a data store where you can use it to create custom reports and
dashboards, and analyze it using a variety of business intelligence tools.

See General data for external reports, later in this document, for more details.

* Integration with Sage Intacct Construction.

If you use Sage Intacct Construction, you can send estimates from Sage Estimating to projects in
Intacct Construction.

See Integration with Sage Intacct Construction, later in this document, for more details.

e SQL Server authentication, which provides a secure means of authentication for companies that require
the convenience of a networked system, but do not have a domain.

See Support for SQL Server authentication, later in this document, for more details.

» Improved performance and usability of the Add User window in the Estimating Management Console.
» The Add User window includes support for SQL Server authentication.

See Improved usability, security, and performance in the Add User window for more details.

* New Price Changed columns you can add to your spreadsheet layouts that show the dates prices last
changed for labor, materials, equipment, subcontracts, and other costs. They can help you to identify
prices you need to update before finalizing an estimate when prices are rising rapidly.

» Afull text search panel that Estimating displays by default for several Estimating grids and dialog boxes.

See Improved search, later in this document, for more details.

e Avariety of performance improvements.

See Improved performance, later in this document, for more details.

* We reorganized the Spreadsheet Report Options so that dependent options are located below their
"parent" option, making the relationships more obvious.

* A new [Prefill tem Spreadsheet Sort] button on the Spreadsheet Report Options tab for printing items in
the same order (ascending or descending) used in the spreadsheet.
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» A new report option to print highlights on spreadsheet reports.

Note: When you select this option, highlights used on the spreadsheet override any background colors
on lump sums, zero amounts, and excluded alternates.

Generate data for external reports

You can use the new External Report capability, available in the Estimating Management Console, to create
snapshots of your data that you can use in custom reports, dashboards, and with business intelligence tools to
analyze data.

The advantage of External Report, compared with Report Manager, is that when you generate data for
external reports, the generated data remains available in a separate location, so you can use it for multiple
reports and comparisons. With Report Manager, the data is removed when you close the report.

The way you generate data is very similar to Report Manager, except that you save data generation settings
for reuse. You can generate data on demand in the Estimating Management Console or use a new Generate
Data icon on the Reports ribbon in Sage Estimating. The data is current at the time you generate it.

Tip: If you need to generate data for a large number of estimates all at once, consider creating a task in
Windows Task Scheduler or running the Estimating External Report Database Generator from the
Windows command line. The executable file, Sage .Estimating.ExternalReportDBGenerator.exe,
is located in Program Files\Sage Estimating\Sage Estimating [version].You can also
double-click this file to run it when you need to refresh your database.

Important! Generate data for large numbers of estimates only when no other users are working with your
Estimating database.

For more information about External Report, see the help for the Estimating Management Console.

Integration with Sage Intacct Construction

If you use Sage Intacct Construction, you can transfer estimate information directly into that program, where
you can use it without having to reenter the information. After exporting an estimate, the estimate information is
available immediately in the following Intacct Construction screens:

e Project Estimates

» Estimate entries (for a particular project estimate)
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The flow of information between Sage Estimating and Sage Intacct Construction is governed by Job Cost
Information settings you select for the estimate or the standard database and by settings you select during an
export.

For more information about setting up the integration and exporting estimate data, see the Estimating help and
the Sage Estimating Sage Intacct Construction Integration Guide.

Support for SQL Server authentication

If you're using Estimating in a non-domain environment, but you want to use Estimating in a networked way,
you can set up Estimating users with SQL Server authentication. This way, you need to set up each user only
once for the instance, but they can log in to the instance from different machines.

. Note: If you've set up Estimating on a domain, you don’t need to use SQL authentication.

The Add User window also includes a new tab for SQL Server Authentication:

Add User — O >

Windows Authentication | SQL Server Authentication
Rale:
Senior Estimator V
User [D:
Mary Little
Password:

Confirm password:

Enforce password policy
Enforce password expiration
User must change password at next login

ok || cancel || @Help |

In contrast to Windows Authentication, where a user must exist in on your local machine or on your domain, for
SQL Server Authentication, you create a new SQL login for users.
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To create a new SQL login:

1.

A w0 N

From the Role list, select the role to assign to the user.

In the User ID box, type the name or ID of the user.

In the Password box, enter the user's new SQL password.

In the Confirm password box, enter the same password again.
Select local security options that you want to enforce for the user:

» Select Enforce password policy to make sure that the user's password meets criteria specified in
Microsoft Windows Security Policy.

» Select Enforce password expiration to make sure that the user changes their password after a
period of time specified in Microsoft Windows Security Policy.

« If you select User must change password at next login, the next time the user tries to log on, they
are prompted to change their password.

Improved usability, security, and performance in the Add User
window

When you open the Add User window, you'll notice that it has a cleaner look:
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Add User — O *

Windows Authentication | SQL Server Authentication
Role:

Jr. Estimator e

User or Group I0:

Users to Add:

User ID| First Name| Last Name

]

Cancel || -Ié Help |

It provides separate tabs for Windows Authentication and (new in version 22.1) SQL Server Authentication.

Improved Windows Authentication

In this version, specifying Windows Authentication appears on its own tab and has several advantages over
earlier versions:

» The tab always displays a list of users in the Users to Add grid, whether or not you select a group.

* You can use a new [Clear] button to reset the Role box to a blank, if you need to add a user without a
role.

 Instead of selecting a user or a group from a list, you can either:

« Type the user ID or group ID in a text box and then click the Verify users or groups (¥+]) button to
verify the user or group name.

After you click the button, if the name or names exist, Estimating displays them immediately in
the grid. (You can also press the Enter key to perform this function.)
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* Click the Select User or Group () button to display a separate Select User or Group window,
where you can browse to users (or groups) and locations that you want to enter in the associated
fields.

¢ You can select local Windows user groups.

¢ A checkbox in the Users to Add header automatically indicates whether any users are selected in the
grid. You can select or clear all the user selections quickly just by selecting or clearing this checkbox.

Improved search

In earlier versions of Estimating SQL, you needed to press Ctrl + F to display a Search window. Now, a full text
Search box appears by default above the grids in a number of windows and dialog boxes.

Using full text search, you can search values, descriptions, and notes. Estimating matches text as you type it,
finding matches even for partial words.

Where the Search box does not appear by default, such as in Takeoff or on the spreadsheet, or if you closed
the Search panel earlier, you can display a Search window by pressing Ctrl + F.

Improved performance

We improved the performance of the following windows and functions:
» Improved performance when loading variables from a large database in the Select Variable dialog box.
» Takeoff passes load much faster in the Pass Audit window.
» Check Models performance is improved.

* Inserting and updating records in Means Integrator is faster.
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Fixes Since the Previous Version

Version 22.1 includes the following fixes:

o Spreadsheet:

Addons that use the Calculate crew items on base rate only option are calculated properly using
the new crew base rate.

You can open an estimate that includes multiple addons that reference the same parent addon.
You can duplicate estimates that have sorted columns.

When you edit spreadsheet layouts that have a large number of locked columns, you no longer
receive an error message saying there are too many locked columns.

Base price columns are not automatically added to custom layouts when you upgrade to version
22.1.

We restored the ability to adjust overline takeoff quantities.

* Reports:

Item notes in plain text appear properly on custom reports.

When you use a range to print an Estimate report, the Estimate Partial Total field shows the total
for the items included in the range. The Estimate Total field always shows the grand total,
regardless of the range you specify.

When you print an Estimate report for an estimate that has allocated addons, the signature block
shows the correct total, even if you don't print the Totals page.

In the Comparison report and the Variance report, description and phase information is always
included even when the compared estimates don't have all the same items.

On the spreadsheet report, horizontal grid lines don't extend past the grid when you minimize
overlines.

In the Spreadsheet Report Options window, your selection for the Shaded Headings option is
saved with the report layout.

The resource summary now prints for Crew Analysis Report.

Long fields that exceed the page width now wrap properly on report cover pages.
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When you create a report layout for a Bill of Materials Quote Sheet, on the Report Options > Sort
tab:

 If you select a New Page for each option, your selection is saved with the report layout.

* If you select Group Phase as the only sort level and select None for the New Page for each
option, no page break is added between group phases.

» Estimating Management Console:

The Security and Report Manager panes display user defined labels.

+ Means Integrator:

« Jo

City cost indexes are updated properly for the Other category.
The city cost index now includes mappings for Division 46.
b Cost integrations:
The job cost system is no longer reset to None when you import estimates.

You can have categories on the spreadsheet even if Sage 300 Construction and Real Estate
doesn't track categories.

We have fixed some issues that caused errors during exports to Job Cost.

Phase total quantities are exported to your job cost program, even when your estimate calculates
overline quantities automatically.

JC Phase codes are now sorted correctly during takeoff.

¢ Miscellaneous:

You can import prices for very large databases in Database Editor.
You can reprice an estimate from crews.

You no longer receive an error when you copy an assembly that has a subcategory, then
substitute an item and change the unit price for the item with the subcategory.

When you edit a model, the changes you save to a dropdown list are available immediately.

When you delete multiple contacts from the Address Book, they are removed properly from the
tree in the catalog pane.

You can delete rate tables from standard databases.

In the Database Editor help, we've fixed the example regarding the price code formats to use for
Excel.
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¢ You can edit Help Notes for database variables.

¢ You can add variables to an item table from variable search results. Also, the search can match
more than 20 characters.
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Revisions to Version 22.1

This section describes enhancements and fixes included in revisions to the software after we released version
22.1.

Note: Each update is cumulative. That is, each successive update includes all the fixes and
enhancements provided in previous updates as well as additional fixes and enhancements in the current
update.

Update 5 (Build 22.1.2309.061, September 2023)

Fixes
Update 5 includes the following software fixes:
» Sage Estimating works as expected when you double-click a row header in the spreadsheet.

» Columns on the Totals page are properly aligned when some totals are hidden.

Update 4 (Build 22.1.2306.082, June 2023)

Fixes
Update 4 includes the following software fixes:

* If you use Sage Estimating with Sage Intacct Construction, the program warns you if you send a job that
has duplicate task names to an Intacct project, and informs you how to correct the problem.

* You can run Sage Estimating on a computer running FIPS (Federal Information Processing Standards)
mode.

Update 3 (Build 22.1.2303.231, March 2023)

Fixes

Update 3 includes the following software fixes:
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When you export estimates that have extras to Sage 300 Construction and Real Estate, the extras no
longer have blank descriptions.

When exporting to Sage 300 Construction and Real Estate Job Cost, you no longer receive an error
when you set the location for a text file.

Notes on external reports, report designs, and custom reports, are properly formatted as plain text.
You can generate external report data even when there are RTF notes on an estimate.

When you combine items on the spreadsheet, Sage Estimating checks to ensure that if the items use a
rate table, the rate tables are the same.

Hiding columns on report totals pages no longer hides the adjacent column.

Update 2 (Build 22.1.2301.251, January 2023)

Fixes

Update 2 includes the following software fixes:

Bid Grid no longer stops you from modifying the quantity when the item category is a part of the Bid
Grid.

When you install or change the address book, the program updates only the address book settings and
does not reset all your current Estimating Management Console settings.

When you export estimates to Sage Intacct Construction, the effective date of project estimate entries is
set to the estimate date.

Exporting estimates to Sage Intacct Construction creates new tasks in Intacct with an In Progress
status.

Means Integrator correctly updates database rate tables with new resources available for crew pricing.
You can again display the Calculation Window when you create database models.

When you regenerate a model with different question and assembly values, old items that are no longer
generated by the assemblies are removed.

When working with a database model, if you select an interview file that Excel cannot open, you receive
an error message explaining what the problem is. For example, you receive an error message if you try
to open a file on a server for which you have no access rights or if the file has been removed or
corrupted. Previously, Excel could get stuck trying to open the file, and you would have to exit
Estimating.
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 Inthe Job Cost Information section of the Estimate Information window, you no longer receive an error

when selecting a job for an estimate for the first time.

Update 1 (Build 22.1.2211.011, November 2022)

Fixes

Update 1 includes the following software fixes:

When you integrate an estimate with a Sage Intacct Construction project, Sage Estimating adds tasks
and cost types as needed to the project, avoiding duplication.

In the Export to Intacct wizard, you can enter 200 characters for the Project Name and 500 characters
for the estimate Description.

For External Reports, you can now sort, group, and filter on the Lock State, Generate, and Delete
columns.

Estimating no longer closes unexpectedly when you view items that were created using eTakeoff
Bridge.

When you copy an item or an assembly to a different estimate, alternate information is copied correctly.

Sage Estimating (SQL) v22.1 Release Notes

15



Known Issues

Checking in a Standard Database from the Database Editor
Closes the Database for Concurrent Users

You can work on a Standard database in the Estimating Database Editor while other users perform takeoff
using the same database in the Sage Estimating program.

When you try to check in the Standard database while other users have the database open, you receive a
warning that if you continue to check the file in, there may be unpredictable results for the concurrent users.

If you continue to check the file in despite the warning, the Estimating program stops working for the other
users. However, the data is not corrupted and the Estimating program is not damaged.

Sage Intacct Construction users need Top Level access in
Sage Intacct

When setting up Sage Intacct Construction users, make sure you set them up at the Top Level in Sage Intacct.
If you set them up at the entity level, they will not be able to sign in to your company.
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Need help?

How to Get Help

Get help by: Recommendation®
View information about the
Reviewing in- current window as well as
product help procedures for using
Estimating.

View documents and
Reading product | reference material from
documentation | the Estimating Product

Documents website.

Search the Sage
Knowledgebase, which
Searching the provides 24/7 access to
Knowledgebase | support articles as well as
the latest software
downloads and updates.

Join industry peers,
certified partners, and
Sage pros online 24/7 in

Asking the
9 . Sage City—the best place
community :
to ask questions and share
product experiences, tips,
and tricks.
K ith the latest
Checking the eep uP.WI e. @ ?S
product information in the
latest product .
Sage City Announcements,
alerts

News, and Alerts forum.

Submit your issue directly
Submitting a web | to our support team using
ticket Online Case submission.

Explonng training Learn how to harness the
options

Sage Estimating (SQL) v22.1 Release Notes

To access:

Click the Help button or icon, or press [F1] to display the
Help topic for that window.

Visit

http://cdn.na.sage.com/Docs/en/customer/estimating/

Documentation.htm

Visit the Knowledgebase at www.sageKB.com

Visit the General Estimating forum at
www.SageCity.com

Visit www.SageCity.com

Visit https://customers.sagenorthamerica.com/irj/
portal/anonymous/login

Visit www.SageU.com
You can also get access to Sage University from the
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Get help by: Recommendation® To access:

full power of your software
through videos and
classes at Sage
University.

Estimating File menu by selecting Help > Sage University.

*Not all options are available for all products. Customer Service hours vary by product line. Access to some
resources require an active Sage Business Care support plan.

Submitting Enhancement Requests

We want to hear your suggestions for improving the software. To send us your comments, click on the File
menu button and then select Help > Submit Product Idea.
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